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Schritt-für-Schritt-Anleitungen auf dem Foliensatz:

� Kommunikationskontrolle on the following page

� Das erste Programm on page 3 (bit_io1).

� Beispielprogramm mit Bitverarbeitung on page 7 (bit_io2).

1 Entwicklungsumgebung

Das Versuchsboard

1
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Inbetriebnahme der Baugruppe

� Programmieradapter anstecken.

� Netzteil anstecken (Achtung, nur 5V- Netzteile verwenden).

� Schaltermodul JA (Port A1) anstecken.

� Erst wenn Hardware fertig zusammengesteckt, einschalten.

Kommunikationskontrolle

� Rechner unter Windows starten

� Web-Browser (Firefox) ö�nen. Foliensatz zum Mitlesen ö�nen:

techwww.in.tu-clausthal.de/site/Lehre

/Informatikwerkstatt/

� Atmel Studio starten .

� Zur Kontrolle, dass der Prozessor richtig angeschlossen und vom System erkannt wird, in
Atmel Studio

Tools > Device Programming

auswählen. Nachfolgende Kontrollen vornehmen:

Kontrolle der Sicherungsbits (Fuses)

� Die Sicherungsbits aktivieren Grundfunktionen, z.B. Programmierschnittstellen, Kopier-
schutz, ...

� Bei Einstellungsfehlern lässt sich der Mikrorechner nicht programmieren, die Programme
funktionieren nicht, ...

1Oben angesteckt: SW1⇒JA.0, SW2⇒JA.1, SW3⇒JA.2, SW4⇒JA.3. Unten angesteckt: SW1⇒JA.4,
SW2⇒JA.5, SW3⇒JA.6, SW4⇒JA.7.
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� Unter �Device Information� �ndet man auÿer einer Kurzübersicht auch das Datenblatt
(Datasheet) des Mikrorechners:

Das Menü �Tools > Device Programming� wird nur zur Kontrolle benötigt, ob der Prozessor
über den Programmer erreichbar ist, Spannung hat, der Prozessortyp stimmt, ...

2 Das erste Programm

Das erste Programm

schreibe Byte auf Port J

Wiederhole immer

Port A (Schalter) Eingang

lese Byte von Port A

Port J (LEDs) Ausgang

#include <avr/io.h>
int main (){

DDRA = 0b00000000; // Port A (Schalter) Eingänge
DDRJ = 0b11111111; // Port J (LEDs) Ausgänge
uint8_t a; // Variable , 8-Bit positiv
while (1) { // Endlosschleife

a = PINA; // Lesen der Schalterwerte
PORTJ = a; // Ausgabe auf die LED

}
}

� Programmierprojekt anlegen.

� Programm eingeben und übersetzen.

� Programm laden. (Hardware zusammenstecken.)

� Programm testen.

Projekt einrichten

� Neues Projekt anlegen:

File > New > Project > GCC C Executable

Project Name: �bit_io1�. Location: H:\Informatikwerkstatt. Prozessortyp: Atmega2560.

� Programmier-Tool / Schnittstelle auswählen:

Project > bit_io1 Properties (Alt + F7) >
Tool > AVR Dragon ..., JTAG
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� Unter Toolchain die Optimierung für den Übersetzer ausschalten:2 (�-O1� durch �-O0�
ersetzen)

� Zeilennummern einschalten:

Tools > Options > Text Editor > All languages > Line numbers
√

� Einstellungen Speichern (Strg + S).

Programm eingeben

� Automatisch erzeugten Programmrahmen vervollständigen3.

#include <avr/io.h>
int main (){

DDRA = 0b00000000; // Port A (Schalter) Eingänge
DDRJ = 0b11111111; // Port J (LEDs) Ausgänge
uint8_t a; // Variable , 8-Bit positiv
while (1) { // Endlosschleife

a = PINA; // Lesen der Schalterwerte
PORTJ = a; // Ausgabe auf die LED

}
}

� Speichern.

� Debugger starten:

Debug > Start Debugging and Break (Alt+F5).

2Optimiert sonst für das Ein-/Ausgabeverhalten entbehrliche Schritte weg, z.B. das Zwischenspeichern von
Variablenwerten im Datenspeicher und Warteschleifen. Optimierte Programme lassen sich nur eingeschränkt im
Schrittbetrieb auf Quellcodeniveau testen.

3Das Beispielprogramm be�ndet sich mit im zip-File auf der Webseite.



Prof. G. Kemnitz, TU Clausthal: Informatikwerkstatt (IW-H1.pdf) 5

Debugger-Ansicht

Nächste auszuführende Anweisung.
Unterbrechungspunkt (Mouse-Click grauer Rand davor).
Schritt abarbeiten und halten.
Fortsetzen bis zum nächsten Unterbrechungspunkt.

Beobachtungsfenster ö�nen

Debug > Windows > IO

Debug > Windows > Watch > Watch1

Programm Testen

Schrittbetrieb:

� Schritt abarbeiten und halten ( ).

� Werte in �IO� und �Watch 1� kontrollieren.

Test mit Unterbrechungspunkt:

� Unterbrechungspunkt setzen4.

� Start/Programmfortsetzung mit .

4Mouse-Click auf den grauen Rand vor der Anweisung
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� Werte in �IO� und �Watch 1� kontrollieren.

� Schaltereingabe ändern.

Test ohne Unterbrechung:

� Unterbrechungspunkt löschen.

� Start/Programmfortsetzung mit .

� Schaltereingabe ändern und LED-Ausgabe kontrollieren.

3 Bitverarbeitung

Bitoperationen

Mikrorechnerprogramme verarbeiten oft einzelne Bits:

� Schaltereingaben, LED-Ausgaben,

� Motor ein/aus, ...

Die Bits sind für die Verarbeitung im Prozessor zu Bytes zusammengefasst. C-Vereinbarung für
1-Byte-Variablen:

uint8_t a, b; //zwei 1-Byte -Variablen

� Byte-Werte kopieren:

a = b;

� Byte nach rechts oder links verschieben:

a = 0b10110111; //a: 0b10110111 = 0xB7
b = a >> 2; //b: 0b00101101 = 0x2D
a = b << 3; //a: 0b01101000 = 0x68

(0b... � Binärdarstellung; 0x...�Hexadezimaldarstellung).

� bitweise Negation:

a = 0b10110111;
a = ~a; //a: 0b01001000

� bitweises UND (Ergebnis 1, wenn beide Operandenbits 1 sind):

a = 0b10011111 & 0b00111101; //a: 0b00011101

� bitweises ODER (Ergebnis 1, wenn mindestens ein Operand 1 ist):
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a = 0b10011111 | 0b00111101; //a: 0b10111111

� bitweises EXOR (Ergebnis 1, wenn genau ein Operand 1 ist):

a = 0b10011111 ^ 0b00111101; //a: 0b10100010

1
0

x0x1

00
0 1
1
1

0
1

x1 ∧ x0 x1 ∨ x0 x1 ⊕ x0

0
0
0
1

0
1
1
1

1
1
0

0

x̄0

Programmieraufgabe: LD0 = SW1 ∧ SW2

Schalter / LED SW1 SW2 LD0

Port, Bit A0 A1 J0

#include <avr/io.h>
int main(void){

DDRA = 0; // Port A (Schalter) Eingänge
DDRJ = 0xFF; // Port J (LEDs) Ausgänge
uint8_t a, b, c; // 8-Bit -Variablen
while (1){

a = PINA & 0b01; // a(0)<= SW1
b = PINA & 0b10; // b(1)<= SW2
c = b >> 1; // c(0)<= b(1)
PORTJ=a & c; // LD(0)<=SW1 & SW2

}
}

Ausprobieren

� Spannung abschalten, Schaltermodul an JA belassen.

� Projekt schlieÿen

File > close solution

� Archiv �Programme.zip� von der Webseite laden und auf Laufwerk H: im neu anzulegenden
Unterverzeichnis �Informatikwerkstatt� entpacken.

� Projekt �F1-bit_io2� ö�nen, übersetzen, laden, ausprobieren.



Prof. G. Kemnitz, TU Clausthal: Informatikwerkstatt (IW-H1.pdf) 8

4 Fallunterscheidung

Binäre Fallunterscheidungen mit �if� und �else�

b1

b̄1 b̄2

b2

A1 A3A2
if (<Bedingung b1 >){
<Anweisungsblock A1>

}
else if (<Bedingung b2 >){
<Anweisungsblock A2>

}
else{
<Anweisungsblock A3>

}

{...} � Zusammenfassung von Anweisungen zu einem Block. bi ∈ {falsch, wahr} � Bedingung,
Darstellung durch C-Variablen:

Wahrheitswert falsch wahr
Bitvektorwert 0 ̸= 0

Operatoren mit Wahrheitswerten als Ergebnis:

� Vergleichsoperatoren: <, <=, ==, !=, >=, > und

� logische Operatoren für Wahrheitswerte: || (logisches ODER), && (logisches UND) und !
(logische Negation).

Beispielprogramm für �LD0 = SW1 ∧ SW2� (PJ.0=PA.0∧PA.1):

while (1){
if ((PINA & 1) && (PINA & (1<<1)))

PORTJ |= 1; // LD0 einschalten
else

PORTJ &= ~1; // LD0 ausschalten
}

Schalter und Leuchtdioden sind gut zur Prüfung logischer Operationen geeignet.

5 Auswahlanweisung

Auswahlanweisung

switch (PINA & 0b1111){//SW4 bis SW1
case 0b0000: PORTJ = 0b10010001;

break;
case 0b0001: PORTJ = 0b01110111;

break;
case 0b0010: PORTJ = 0b11100110;

break;
...
default: PORTJ = 0b10111111;

}



Prof. G. Kemnitz, TU Clausthal: Informatikwerkstatt (IW-H1.pdf) 9

w2 · · ·
· · ·A2A1

w1

LD8
LD7
LD6
LD5
LD4
LD3
LD2
LD1

SW1
SW2
SW3
SW4

0 1 0
10 0

0 0 0
0 0 0

so
n
st

sonst

Asonst

Auswahlausdruck

� Die auszuführende Anweisungsfolge reicht von �:� bis �break�.

� Ohne �break� werden auch die Anweisungen des nächsten Auswahlfalls mit abgearbeitet.

� �default� steht für alle anderen Werte.

6 Automaten und Warteschleifen

Funktion und Automat

� Eine Funktion berechnet eine Ausgabe y aus Eingaben x:

y = f (x)

z.B. die LED-Ausgabe aus Schaltereingaben.

� Ein Automat ist ein Berechnungsmodell mit einem zusätzlichen Zustand z, einer Über-
gangsfunktion

zn+1 = fz (zn, xn)

und einer Ausgabefunktion:
yn+1 = fy (zn, xn)

(n � Nummer des Berechnungsschritts).

� Beispielautomat als Graph:

Z1
PORTJ=0b10PORTJ=0b01

Z0
PINA==0b01

PINA==0b10

sonstsonst

Automaten- und Operationsablaufgraphen

� Ein Automatengraph beschreibt die Zustände durch Knoten und die Zustandsübergänge
durch Kanten.

� Die Ausgabe können den Zuständen oder, wenn sie von der Eingabe abhängen, den abge-
henden Kanten zugeordnet sein.

yyy
xxx

Zustandsübergang
Eingabe (∗Übergangsbedingung)

Kennzeichnung des Anfangszustands

bbb

Zustand
Zustandsname
Ausgabe (∗Ausgabeoperationen)

∗ Erweiterung zur Steuerung von Operationsabläufen

� Bei einem Operationsablaufgraphen können die �Ausgaben� auch gesteuerte Operationen
und die Übergangsbedingungen aus Operationsergebnissen gebildet werden.
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Vom Automatengraph zum Programm

Z1
PORTJ=0b10PORTJ=0b01

Z0
PINA==0b01

PINA==0b10

sonstsonst

#include <avr/io.h>
int main(void){
DDRA = 0; DDRJ = ~0; // Ports initialisieren
PORTJ = 0b01; // Anfangswert zuweisen
while (1){
switch (PORTJ & 0b11){ // Unterscheidung Zustand
case 0b01:
if (PINA ==0 b01) PORTJ = 0b10; break;

case 0b10:
if (PINA ==0 b10) PORTJ = 0b01; break;

default: PORTJ = 0b01;// bei unzulässigem Zustand
}

}

Warteschleifen

� Ein anderer Operationsablauf:

Z1
PORTJ- -PORTJ++

Z0
PINA==0b01

PINA==0b10

sonstsonst

- - Verringerung um eins++ Erhöhung um eins

� Die Zeit zwischen zwei Zustandsübergangen beträgt wenige µs.

� Für den Test mit Schaltern und LEDs ist die Dauer der Berechnungsschritte mit einer
Warteschleife in den Sekundenbereich zu verlängern.

� Eine Warteschleife ist eine Zählschleife, die Zeit verbraucht und sonst nichts tut, z.B.:

for (uint32_t Ct=0; Ct <200000; Ct++); //ca. 250ms

PORTJ++

PINA==0b01

PINA==0b10

sonst
Z0 (z=0)

PORTJ- -
Z1 (z 6=0)

PORTJ=0

#include <avr/io.h>
int main(void){
DDRA = 0; DDRJ = ~0; // Ports initialisieren
uint8_t z = 0; // Zustandsvariable
while (1){
switch (z){ // Unterscheidung Zustand
case 0:
PORTJ ++;
if (PINA ==0 b01) z = 1; break;

default: // auch für unzul. Zustände
PORTJ --;
if (PINA ==0 b10) z = 0; break;

}
for (uint32_t Ct=0; Ct <200000; Ct++); //ca. 250ms

}
}
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Pseudo-Zufallszahlengenerator

� Pseudo-Zufallsgenerator: Automat, der vom Startzustand aus zylisch eine pseudo-zufällige
Zustandsfolge durchläuft.

� Beispiel 8-Bit-Rückgekoppeltes-Schieberegister (LFSR Linear Feeback Shift Register):

0 0 0 0 01 1
0 0 0 0 01 1

0 0 0 0 01 1

z7 z0z1z2z3z4z5z6

1
0

0

0 0 0 1
0 0 0 1 1

0 0 0 01 10
0

0

0
0

0
1

11

� Übergangsfunktion:

z7 = z4 ⊕ z3 ⊕ z2 ⊕ z0

zi = zi+1 für i ∈ {0, 1, 2, . . . 6}

0 0 0 0 01 1
0 0 0 0 01 1

0 0 0 0 01 1

z7 z0z1z2z3z4z5z6

1
0

0

0 0 0 1
0 0 0 1 1

0 0 0 01 10
0

0

0
0

0
1

11

...
uint8_t z = 0b00110001; // 0x31;
while (1){

z = (z>>1) | (((z< <7)^(z< <5)^(z<<4)^(z<<3)) & (1<<7));
PORTJ = z; // Ausgabe
... // Warteschleife

}

Pseudo-Zufallszahlen dienen z.B. als Testeingaben für den Programmtest.

7 Aufgaben

Aufgaben

Für alle:

� Handout zum aktuellen Foliensatz noch mal lesen.

� Schritt-für-Schritt-Anleitungen ausprobieren.

� Vorbereitung auf die Beantwortung der Wiederholungsfragen auf dem nächsten Handout.

Browser starten: �google techwww�, Informatikwerkstatt, ... und Datenmaterial auf der Web-
Seite durchblättern.

Die weiteren Programmieraufgaben richten sich nach den individuellen Vorkenntnissen.

Die nachfolgenden Aufgabenstellungen sind Vorschläge, die auch abgewandelt werden dürfen.

Funktionierende Programme sind dem Betreuer zur Kontrolle der erbrachten Leistungen vorzuführen.
Richtwert: je Teilnehmer alle 2 Wochen mindestens eine Aufgabe angemessener Schwierigkeit.
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Aufgabe 1.1: Logik mit Schaltern und LEDs

1. Schreiben Sie in Anlehnung an das Projekt �bit_io2� ein Programm, dass in der End-
losschleife bei jedem Durchlauf die Schalterwerte an PortA einliest und auf die LEDs an
Port J folgende logische Ausdrücke ausgibt:

� LED0 = SW1 & SW2 & SW3 & SW4

� LED1 = (SW1 | SW2) & (SW3 & SW4)

� LED2 = SW1 & (SW2 ^ SW3 ^ SW4)

� LED3 bis LED7 selbst wählbare Ausdrücke.

2. Zeichnen Sie sich eine Wertetabelle wie auf der nächsten Folie auf Papier und füllen Sie
diese aus.

3. Kontrollieren Sie für alle 16 möglichen Schaltereingaben anhand der ausgefüllten Werteta-
belle, dass die richtigen Leuchtdioden leuchten.

0 0 0 0 0 0 0 0
0 0 0 01 1 1 1
1 1 1 1 1 1 1 1

1 1 1 1

0 1 0 1
1 10 0

0 1 0 1
1 10 0

0 0 0 0

0 1 0 1
1 10 0

0 1 0 1
1 10 0

SW1
SW2
SW3
SW4
LED0

LED7
LED6
LED5
LED4

LED2
LED1

LED3

Hinweise:

� Entwickeln Sie das Programm LED-weise, d.h. zuerst nur für die Ausgabe auf eine LED.
Dann Testen und Fehlerbeseitigung. Dann für die Ausgabe auf zwei LEDs etc.

� Nutzen Sie den Debugger, Schrittbetrieb, Unterbrechungspunkte, ...

Aufgabe 1.2: Lau�icht-Programm

PORTJ
Z0 PINA==0b01

PINA==0b10

Z1

PORTJ
PORTJ=1

sonst

sonst

Programmieren Sie den Ablauf zur Erzeugung eines Lau�ichts oben:

� Bei Programmstart ist PORTJ mit 1 zu initialisieren.

� Im Zustand Z0 soll auf den LEDs die �Eins� nach links und

� in Zustand Z1 nach rechts rotieren.

Schrittdauer mit Warteschleife auf ≈ 500ms einstellen.

Hinweis: Eine Anregung für die Programmierung der Rotationen (Verschiebung im Kreis) �nden
Sie im Beispielprogramm für das rückgekoppelte Schieberegister.
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Aufgabe 1.3: Pseudo-Zufallszahlengenerator

0 0 0 0 01 1
0 0 0 0 01 1

0 0 0 0 01 1

z7 z0z1z2z3z4z5z6

1
0

0

0 0 0 1
0 0 0 1 1

0 0 0 01 10
0

0

0
0

0
1

11

1. Schreiben Sie ein Programm, dass ausgehend vom Startwert 0b00110001 mit der Über-
gangsfunktion des rückgekoppelten Schieberegisters oben mit einem Zyklustakt von ca. 1 s
zyklisch alle Zustände durchläuft und an die LEDs an Port J ausgibt.

2. Übernehmen Sie die Tabelle auf der nächsten Folie auf Papier und füllen Sie sie aus.

LED7
LED6
LED5
LED4
LED3
LED2
LED1

0x
31

Schritt 1 2 3 4 5 6 7 8 9 101112131415161718192021222324
LED0

Hinweise:

� Zum notieren der Zustandsfolge bietet sich die Nutzung von Unterbrechungspunkten an.

� Der Automat arbeitet zyklisch. Nach Erreichen des Anfangszustands 0b00110001 (0x31)
wiederholt sich die Zustandsfolge.

Aufgabe 1.4: 7-Segment-Decoder (Experten)

Stecken Sie ein �PmodSSD� (siehe Bild) an zwei benachbarte freie Ports und steuern Sie es so
an, das die rechte Zi�er den Hex-Wert der Schaltereingabe an Port A anzeigt.
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8 Zusatzmaterial

C-Programmierung

// Kommentar bis Zeilenende
/*
Kommentar über mehrere Zeilen

*/

// einfügen der Datei io.h aus dem Header -
// Verzeichnis avr. Der Header io.h enthält
// z.B. die Definition von PINA und PORTJ
#include <avr/io.h

int main()
{
... // * Anweisungen , die nacheinander
... // auszuführen sind.

}

Aufgabe 1.5: Programm vervollständigen

#include <avr/io.h>
uint8_t a; // Variablenvereinbarung
int main (){
DDRA = ; //Port A Eingänge
DDRJ = ; //Port J Ausgänge
uint8_t b;
while (...){ // Endlosschleife
a = ; // Eingabewerte lesen

//a.0=(a.0&a.1)|(a.2&a.3)
;

; // Ausgabe an Led 0 ohne
} // andere Led's am Port J

} //zu ändern

1. Was passiert, wenn die Include-Anweisung fehlt?

2. Vervollständigen Sie das Programm.

Lösung

1. Compiler meldet DDRB, PINB oder PORTB nicht de�niert.

2. Vervollständigtes Programm:

#include <avr/io.h>
uint8_t a; // Variablenvereinbarung
int main (){
DDRA = 0 ; //Port A Eingänge
DDRJ = ~0 ; //Port J Ausgänge
uint8_t b;
while( 1 ){ // Endlosschleife
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a = PINA ; // Eingabewerte lesen
a = (a & (a> >1)))| //a.0=(a.0&a.1)|(a.2&a.3)

((a>>2)&(a> >3));
PORTJ = (PORTJ &(~1))|(a&1);// Ausgabe an Led 0

} //ohne andere Led's am
} //Port J zu ändern

Aufgabe 1.6: Programm vervollständigen

#include <avr/io.h>
int main (){
DDRA = // Init. als Eingänge
DDRJ = // Init. als Ausgänge
... a; // Vereinbarung 8-Bit -Variable
while (...){ // Endlosschleife
... // Lesen der Eingabe in a

// EXOR des gelesen mit dem nach
// recht verschobenen gelesen
// Wert
// löschen der Bits 1 bis 7
// Ausgabe Bit 0 auf PJ.4 (LED5)

}
}

Ergänzung, so dass in einer Endlosschleife an PJ.4 die EXOR-Verknüpfung von PA.0 PA.1 aus-
gegeben wird.

Lösung

#include <avr/io.h>
int main (){
DDRA = 0x00; // Init. als Eingänge
DDRJ = 0xFF; // Init. als Ausgänge
uint8_t a; // Variablenvereinbarungen
while (1){ //
a = PINA; // Lesen der Eingabe in a
a = (a>>1)^a;// EXOR des gelesen mit dem nach

// rechtverschobenen gelesen Wert
a = a & 1; // löschen der Bits 1 bis 7
PORTJ = a<<4;// Ausgabe Bit 0 auf PJ.4 (LED5)

}
}

Aufgabe 1.7: Vor/Rückwärtszähler (Reeng.)

PORTJ++

PINA==0b01

PINA==0b10

sonst
Z0 (z=0)

PORTJ- -
Z1 (z 6=0)

PORTJ=0

Ergänzen Sie im Programmrahmen auf der nächsten Folie:

� Einstellung der Anschlüsse PA.0 und PA.1 als Eingänge und der von Port J als Ausgänge.

� Schrittfunktion:
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� Anfangszustand nach Programmstart: z=0 und PORTJ=0.

� Wenn Eingabe PA=0b01: Wechsel nach z=1.

� Wenn Eingabe PA=0b10: Wechsel nach z=0.

� Sonst Zustand unverändert.

� In Z0 wird Port J hoch- und in Z1 runtergezählt.

� Schrittdauer ≈ 2 s (Warteschleife).

PORTJ++

PINA==0b01

PINA==0b10

sonst
Z0 (z=0)

PORTJ- -
Z1 (z 6=0)

PORTJ=0

#include <avr/io.h>

... z=0; // Typ? WB: 0 bis 1

... Ct; // Typ? Zähler 0 .. 400000

int main (){
DDRA = ... ; // PA0 und PA1 Eingänge

DDRJ = ... ; // Port J Ausgänge

PORTJ = ... ; // Anfangswert 0

... { // Endlosschleife

... // Übergangsfunktion siehe

... // nächste Folie
} // Welcher Block endet hier?

}

PORTJ++

PINA==0b01

PINA==0b10

sonst
Z0 (z=0)

PORTJ- -
Z1 (z 6=0)

PORTJ=0

Übergangsfunktion:

while (1){ // Endlosschleife

if (... ){ // Wenn Zustand Z0
... ;// Port J hochzählen
if (... ) ;// PINA ==0b01 , Zustand=Z1

}

else { // sonst
... ;// Port J runterzählen
if (... ) ;// PINA ==0b01 , Zustand=Z1

}
for ( ); // Warteschl. 2s

}
}
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Lösung:

#include <avr/io.h>
uint8_t z=0
int main (){
DDRA = ~0x03; // PA0 und PA1 Eingänge
DDRJ = 0xFF; // Port J Ausgänge
PORTJ = 0; // Anfangsausgabewert
while (1){ // Endlosschleife

if (z == 0){ // Wenn Zustand Z0
PORTJ ++; // Port J hochzählen
if (PINA &3==1) z=1; // wenn PINA ==0b01 , Zustand=Z1

else { // sonst
PORTJ --; // Port J runterzählen
if (PINA &3==2) z=0; // wenn PINA ==0b10 , Zustand=Z1

}
for (u32_t ct=0;ct <400000; ct++);// Warteschleife

} // Welcher Block endet hier?
} // Welcher Block endet hier?

Aufgabe 1.8: Lau�icht

PORTJ
Z0 PINA==0b01

PINA==0b10

Z1

PORTJ
PORTJ=1

sonst

sonst

#include <avr/io.h>
... ;//8-Bit Variable a
int main (){
... ;//Port A (Schalter ): Eing.
... ;//Port J (Led): Ausgänge
while (1){ // Endlosschleife
for ( ... );// Warteschleife
if ( ... ) //wenn SW1=1
... ;// Rotation a links

else //sonst
... ;// Rotation a rechts

... ;// Ausgabe a an die Led
}

}

Aufgaben hierzu:

1. Testen Sie das Beispielprojekt �bit_io3� (nächste Folie).

2. Unterschiede zwischen der Ziel- und der Ist-Funktion?

3. Korrigieren Sie das Programm.
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PORTJ
Z0 PINA==0b01

PINA==0b10

Z1

PORTJ
PORTJ=1

sonst

sonst

Aufgaben hierzu:

1. Testen Sie das Beispielprojekt �bit_io3� (nächste Folie).

2. Unterschiede zwischen der Ziel- und der Ist-Funktion?

3. Korrigieren Sie das Programm.

Lösung

PORTJ
Z0 PINA==0b01

PINA==0b10

Z1

PORTJ
PORTJ=1

sonst

sonst

#include <avr/io.h>
uint8_t a=1; //8-Bit Ausgabewert
int main (){
DDRA = 0; //Schalter -Port: Eingänge
DDRJ = 0xFF; //LEDs -Port: Ausgänge
while (1){ // Endlosschleife
for (uint32_t Ct=0; Ct <200000; Ct++); // Warteschleife
if (PINA & 0b1) //wenn SW1=1
a = (a<<1) | (a>>7) ; // Rotation links

else // sonst
a = (a>>1) | (a<<7) ; // Rotation rechts

PORTJ = a ; // Ausgabe
}

}


